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Introduction
af

This section provides valuable information about teaching TechnoTravel. It
includes an overview of the course. In addition, there are ideas for
implementation and technology integration.

For additional guidance, open the course in TechnoHub and select Get
Started to access preparatory steps, resource list, and scheduling timetable.

TechnoTravel Overview
TechnoTravel Course Outline

Technology Integration Ideas



Getting Started

TechnoTravel Overview

In this course, students become travel agents. They create an advertisement for
a weekend getaway. To start, students use the Internet to research the
destination. Afterwards, they design an informative advertisement in Microsoft
PowerPoint that will entice tourists to take the trip. The vacation is then

promoted to customers. i

Students complete the following tasks:

» In Session 1, students become travel agents. They plan a weekend getaway. To
start, students consider how travel has changed the way people live and work.
Next, they study a sample travel advertisement to get ideas for their trip.
Afterwards, students use the Internet to research facts about the location. This
information is organized under headings in a Microsoft Word document. Finally,
students use the Internet to save pictures and a map of the travel destination. At
the end of the session, students should have the information they need to create
a travel advertisement for the weekend getaway.

» In Session 2, students begin to create their travel advertisement for a weekend
getaway. To start, they are introduced to the Microsoft PowerPoint environment.
Once familiar with the location of commonly used commands, students learn
how to customize the slide master to make a unique design for their
advertisement. Upon completion, students use the slide master to create a title
and introduction slide.

» In Session 3, students create a travel itinerary that outlines the activities, site
seeing trips, and events planned for the weekend getaway. Using a table,
students organize the activities for each day. The table is formatted to look great.

» In Session 4, students create slides to describe each event or site that tourists will
see on the weekend getaway. Students will use Normal View and Outline View to
create the slides. At the end of the session, each activity in the travel itinerary
should have a slide in the travel advertisement.

» In Session 5, students complete the content of the travel advertisement. To start,
they insert a map of the destination on a slide and use shapes to highlight the
city. Afterwards, students create a slide that contains hyperlinks to websites on
the Internet that tourists will find helpful.

» In Session 6, students promote the weekend getaway to tourists. To begin they
edit the content and layout of each slide. Using the Spelling command students
identify and correct spelling errors. Afterwards, they view the presentation in Slide
Sorter View to adjust the order of the slides. Next, students release the travel
advertisement in various formats that are suitable for advertising purposes. The
slideshow is prepared for a kiosk and a handout is printed. The travel
advertisement is shared with viewers to entice tourists to go on a weekend
getaway.

Copyright © TechnoKids Inc. ii TechnoTravel | Microsoft 365



Getting Started

TechnoTravel Course Outline

Purpose: Organize a weekend getaway Preparation:

and promote the trip to tourists. e Install Microsoft 365

Objectives: (see Appendix A: Skill Summary) e Share Travel folder with students
e Download Flashcards and Tool Summary from
TechnoHub (optional)

e research facts about a destination

e create an advertisement to promote a trip
e customize a slide master Materials:
e organize trip details onto slides

e provide advice about visiting a location

e schedule an itinerary of activities

e pinpoint the location of a place on a map
e connect tourists to additional information

e design an interactive street map (optional)
e calculate travel costs (optional)

e compare airfare or room rates (optional)

Summary of Activities:

e Assessment: Checklists, Reviews, Marking Sheets,
Skill Summary

Sample: Travel Advertisement

Sample: Travel Costs

Parent Letter and Certificate (optional)
Flashcards and Tool Summary (optional)

e Gain insight into the reasons people travel.

e Become a travel agent. Learn about the profession. Watch a promotion for a weekend getaway.
e Use suggestions to pick a travel destination.

e Research a travel destination and organize information on a Fact Sheet in Microsoft Word.
Gather images for the travel advertisement. Respect copyright when saving files.

Learn about the PowerPoint window and commands.

Customize the slide master to produce a unique design and layout.

Test the layout and design of the slide master by making a title and introduction slide.
Complete the introduction slide by adding content and a picture. Explore formatting options.
Plan a travel itinerary of activities.

Design an itinerary using a table. Format the style to make the information easy to read.
Create an activity slide for an activity in the itinerary. Crop an image to improve the appearance.
Create another activity slide in Outline View. Add variety to the text using the thesaurus.
Complete the itinerary slides. Use a checklist to edit the content and layout.

Mark a map to show the travel destination using symbols and WordArt.

e Provide tourists with additional information by linking slide objects to travel guides.

o Edit the travel advertisement. Spell check the text. Rearrange slide order.

e Setup the advertisement in kiosk mode. Add transitions and adjust slide show settings.

¢ Print the advertisement as a flyer or brochure. Edit the handout master and set print settings.

e Export the advertisement as a video. Explore sharing options.

e Advertise the weekend getaway.

Extension Activities:

e Book Flight or Accommodations: Compare airfares and room rates to find the best deal.

e Create a Fancy WordArt Style: Edit the title on the slide master to create a unique design.

e Calculate Travel Costs: Use Microsoft Excel to calculate the cost of the activities in the itinerary.

¢ Animate the Travel Advertisement: Animate slide objects and set the timing to automatically play.
e Design an Interactive Map: Mark each activity on a map with links to related websites.

e Make a Video Clip: Record a video of a tourist or testimonial. Insert into the advertisement.

Assessment:

¢ Self-Evaluation Checklists: Research and Images CheckKlist, Slide Master Checklist, Travel
Advertisement Checklist

e Reviews: About Tables, Outline View and Normal View, Hyperlinks and Hotspots

e Teacher Evaluation: Travel Research Marking Sheet, Travel Advertisement Marking Sheet, Travel Skill
Summary

Notes:

¢ This course requires students to research facts about a destination. If time is a constraint you may
wish to pick a familiar location.
e Students customize the slide master. If this skill is too advanced, skip Assignment 7.
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Technology Integration Ideas

TechnoTravel integrates into curriculum. Students organize a weekend getaway for tourists. The
advertisement they create to promote the trip blends technology skills with geography
concepts. Select a topic based on an area of study. Need inspiration? Refer to these ideas:

¢ Showcase a Destination: Organize a trip to a popular city or town. Select events and
attractions that are a must-see for tourists. When creating the itinerary be sure to include
time for souvenir shopping.

¢ Be a Hometown Hero: Recognize the value of your local community. Design a trip that
highlights the main attractions in your city or town. Use your insider knowledge to include
the best places to eat, shop, or have fun.

e Celebrate Cultural Differences: Feature a place and its people. Plan a trip that has
tourists experience the local culture and environment first-hand. Include festivals, folklore,
history, and unique dining experiences.

e Cruise the Waterways: Sail along a coastal region. Visit beaches, reefs, and places along
the shore. Include water-based activities that will entice tourists.

¢ Hop Off the Beaten Path: Escape the routine of daily life. Find a place that is remote or
lesser known. Decide how tourists will reach the secluded location. Coordinate outings
that travelers who prefer less touristy areas will enjoy.

e Escort Tourists on a Bus Trip: Outline a round-trip tour of a region that lasts two days. Use a
road map to plot a driving route. It should take tourists from one destination to another
until finally returning to their starting point. Include opportunities to socialize with travel
companions.

e Plan a Biking or Walking Tour: Examine a road map of a city or town. Chart a realistic
route that tourists will either walk, hike or bike over a two-day period. The trip should
provide an opportunity to learn about the local area with scheduled stops along the
way.

¢ Jump Aboard a Train: Select a railroad line through an interesting location. Study the
train schedule. Choose several points where travelers will stop at a station to explore an
area and then hop back on to continue with their journey.

e Promote Environmental Stewardship: Help people develop a greater understanding of
the importance of protecting nature. Create an ecotour that takes tourists into natural
areas. Infuse education into the activities to cultivate an appreciation for the
environment.

¢ Have an Outdoor Adventure: Escape the city to a wilderness retreat. Select an area to
explore by trekking, climbing, or paddling. Design a memorable excursion that allows
people to connect with the landscape and wildlife.

e Indulge a Hobby: Design a trip that caters to enthusiasts. It can be based on a hobby,
sport, or an area of intense interest. The vacation should include sites, events, and dining
experiences that relate to tourists' passion.

e Visit a Historical Site: Come face to face with history. Pick a place that is historically
significant. Tour the area to see famous buildings, monuments, memorials, landmarks, or
museums.

e Follow a Famous Route: Walk in the footsteps of an explorer. Choose a section of their
route or expedition. Visit locations that emphasize historical moments, hardships
overcome, or the importance of their discoveries.
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o Transport Back in Time: Pretend you have a time machine. Arrange a trip to an ancient
civilization. Apply knowledge of the class structure, housing, diet, values, beliefs, and
daily activities to form a unique experience for tourists.

e Explore the Undiscovered: Imagine a trip to an unexplored part of the universe using
futuristic technology. Visit a celestial body in the solar system or plunge to the deepest
depths of the ocean. Use facts collected from probes or other scientific investigations to
organize trip details.

e Recount a Person's Story: Remember the life of a famous person such as an artist,
musician, politician, or scientist. Create a two-day tour that highlights their
accomplishments. Visit where they were born, worked, overcame an obstacle, or made
an important discovery. Be sure to honor their achievements by stopping by a memorial.

e Trace Your Ancestry: Pretend you are planning a reunion. Research your family's history
by interviewing relatives and studying photographs. Design a two-day tour that pinpoints
important places in an old neighborhood. Recreate family photos or special moments
such as a picnic or party.

e Reproduce a Family Vacation: Use your personal experience to plan a weekend
getaway. Think about a trip that you have taken in the past. Arrange your favorite parts
of the holiday into a two-day vacation for families.

¢ Make a Difference: Combine volunteering with tourism. Design a trip package that has
volunteers offer their services and skills to benefit a community. For example, tourists may
take part in a sports program, orphanage, building project, farming practice, or
environmental protection effort. During free time, arrange for sightseeing activities.

¢ Unleash the Inner Artist: Blend sightseeing with art instruction. Pick a scenic location that
inspired a famous artist or provides an inspiring landscape. Offer workshops such as
sketching, watercolor, oil painting, or photography. Tourists create their own artwork
under the guidance of a tutor.

¢ Dream Up an Imaginary World: Invent your own place. Determine the landscape,
climate, population, language, currency, capital city, and other important features.
Based on these decisions, build a one-of-a-kind tourist experience.

¢ Map a Novel: Highlight the setting of a story. Take a tour of places where the main
characters live, work, learn, play, or travel. Fill the itinerary with events that showcase
meaningful activities from the story.

e Immerse in a Movie or Show: Guide tourists to recognizable locations from a favorite
show or movie. Have them follow in the steps of a favorite character or recall a
memorable scene. Use the storyline to select accommodations, restaurants, and sources
of entertainment.

o Participate in an Unforgettable Event: Pick an occasion such as a concert, game,
conference, or festival. Organize a weekend getaway for attendees that revolve around
the event. Choose accommodation and activities that are close to the venue.
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Session 1
B ¥ Select a Travel Destination

In this session, students become travel agents. They plan a weekend getaway.
To start, students consider how travel has changed the way people live and
work. Next, they study a sample travel advertisement to get ideas for their trip.
Afterwards, students use the Internet to research facts about the location. This
information is organized under headings in a Microsoft Word document.
Finally, students use the Internet to save pictures and a map of the travel
destination. At the end of the session, students should have the information
they need to create a travel advertisement for the weekend getaway.

Assignment 1: About Travel and Tourism
Assignment 2: Become a Travel Agent
Assignment 3: Pick a Travel Destination
Assignment 4: Research a Travel Destination

Assignment 5: Gather Images for the Travel Advertisement

Session 1 Extension Activity: Book Flight or Accommodations



This is a preview of the teacher guide.
Pages have been omitted.

TECHNOKids



Session 1

Assignment 2 Become a Travel Agent

You are going to become a travel agent. A travel agent is a person that provides travel and
tourism services. Learn more about this profession.

How Does a Travel Agent Help People Travel?

1. A travel agentis a person whose job it is to plan trips for other people.
Check the job duties you would enjoy doing.

v
listen to customers and make recommendations based on their interests and needs
research a location to learn about places to stay, visit, or eat
promote trips to customers
provide advice about visiting the location such as things to bring or safety tips
schedule an itinerary of things to do such as excursions or day trips
calculate travel costs and pick options that fit within a budget
arrange transportation to and from a location
reserve accommodations
make alternative arrangements if travel plans unexpectedly change

Imagine Yourself as a Travel Agent

2. Invent a name for your travel agency.

3. You are going to plan a weekend getaway. What type of trip would you like to plan?
O family fun [0 school outing O business conference
[0 ecotour 0 outdoor adventure O bus or rail trip
O river cruise O bike or walking tour O destination wedding
O seniors retreat O other:

4, Describe the person that would take this trip. For example, what is their age, gender,
hobbies, or interests?

5. You will plan a two-day itinerary. Which activities would tourists on the getaway like?
Check all that apply.
O shop for souvenirs O watch a performance O visit an aquarium or zoo
O tour a building or site O take part in a festival O go to a theme park
O attend a sporting event O visit a museum or gallery [ hike or bike ride
0 connect with nature O other:

Copyright © TechnoKids Inc. 4 TechnoTravel | Microsoft 365
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Watch a Travel Advertisement and Answer the Questions

Travel agents promote trips to customers. You are going to create an advertisement for a
weekend getaway using Microsoft PowerPoint. View the sample to get ideas.

> Open the Travel folder. (Ask your teacher where this is located.)

> Open the file travel advertisement.

Weekend Getaway
Niagara Falls

Travel Agent: Jake Rayner

Watch the advertisement.

When finished, press the Esc keyboard key.

6. What information was included in the advertisement?
map, facts about destination, climate information, travel itinerary,
details about each site or event in the travel itinerary, pictures,

hyperlink to websites on the Internet about the destination

7. What site or event in the advertisement would you like to do?
8. Each slide has a similar design. Why is it a good idea to have a consistent look for each
slide?

It makes the advertisement look professional.

Copyright © TechnoKids Inc. 5 TechnoTravel | Microsoft 365
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Assignment 4 Research a Travel Destination

One of the duties of a travel agent is to learn about an area. They research a

A= location to identify places tourists will enjoy.
°
9 \ In Assignment 3 you picked a travel destination. In this assignment, you research
/ the location. Follow the instructions to organize the facts using Microsoft Word.

You will use the information in upcoming assignments to arrange trip details.

SUGGESTED RESEARCH QUESTIONS:

Where is the destination located?

What is the climate?

What sites or attractions can tourists see when they visit?

What events or activities can tourists participate in during their stay?
What facts make the location interesting to tourists?

Which websites have the best travel advice for visitors to the area?

Create a Fact Sheet in Microsoft Word

> Open Microsoft Word.
Click Blank document.

Click File and choose Save.

Go to the place where you save your work.
Name the file Destination Fact Sheet.

> Click Save.

Organize the Fact Sheet
> Type the title Destination Name. Press ENTER twice.

> Type research headings. Leave space to add facts.

Location Destination Name
. Location
Climate The fact sheet
. Climate
] will help you to
Sites or Events organize facts. Sites or Events

) Interesting Facts
Interesting Facts

@ Websites
Websites

> Format the headings to make them stand out. Select the first heading. On the Home tab,
find the Font group, and use the checklist below to format each heading.

O Change the font. [clbri o | f \

O O O o o

SAVE TIME! Copy the formatting:
1 -H v

O Change the font size. 1. Format one heading. Select it.

O Make the letters look darker. B 2. Double click Format Painter. <
3. Click and drag over top of each of

O Make the letters slant. I the remaining headings.

. U 4. Press the esc key when done.
0 Putaline under the letters. & K /
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Research Facts About the Destination

Use the Internet to learn about your travel destination. It is a good idea to collect
more information than you need. That way you can pick and choose which sites,
events, or interesting facts you want to include in your travel advertisement.

@
Q=N

. )

To arrange trip details, you will need the following information:

e country where the travel destination is located
o useful facts about the climate (temperature, rainfall, weather patterns, seasons)
¢ information about two sites or events that tourists will enjoy

e two interesting facts about the destination that will entice tourists to visit
LEAVE THE FACT SHEET OPEN.

Open a web browser.
Type www.google.com. Press ENTER.

> In the search box, type destination name tourist information.
Click Search or press ENTER.

destination name tourist information

Pick a search result about your topic.
Scan to find a fact you need.
Click and drag to select the fact. Right click and select Copy.

Are you ready for a unigue sightseeing opportunity with breathtaking views of the

Falls and beyond? Then head on down to Clifton Hill and take a ride on Canada's

largest abservation wheel, the Niagara SkyWheel. [l =V EVER ARl =H RV E1g

he Niagara Falls horizon, the Niagara SkyWheel is the newest, most exciting way to

Copy Ctrl+C
SE&F(h%{ for “Towering 173 feet (33 metres) over the Niagara...”
ou will be treated  Print... Ctel+P

ABOUT PLAGAIRISM

Plagiarism is when you copy someone else's work and pretend it is your own. You will be changing the
information you are collecting into YOUR OWN WORDS when you organize the facts into a travel
advertisement.

> Return to the fact sheet by clicking the Word icon in the taskbar.

> Click below the correct research heading to position the cursor.
Right click and choose Keep Text Only from the Paste options. i

Destination Name

Location

Climate |_ﬂ[j Paste Options:
Sites or Events / ]
Pasted fact about the topic. _:7 —> A

> Use your skills to continue to gather facts about the travel destination.

Copyright © TechnoKids Inc. 8 TechnoTravel | Microsoft 365
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Gather Tourism Website Addresses About the Destination

Tourists may want to learn more about the destination. Find two websites that
have information that visitors to the area will find helpful. Look for an official site
by a local tourism agency or an online travel guide. Copy the website
address and paste it under the Websites heading.

Use your skills to find a website with travel tips for tourists.

Click and drag to select the website address in the address bar of the browser.

Right click on the selection. Click Copy.

ttp://www.travelguide.com

> Return to the Word document and click below the Websites heading.

Right click and choose Keep Text Only from the Paste options. [ty

Sites or Events
Interesting fact about a site or event.
Interesting fact about a site or event.

ﬁj Paste Options:
Websites /

http://www.travelguide.com E"I
A

OPTIONAL - Collect More Website Addresses:

Use your skills to copy websites related to the sites or events you researched in the previous step. This
will allow you to return to them later to gather more facts or images. You can also use them in the
travel advertisement to create hyperlinks that connect customers to additional information.

Complete the Research Checklist

Use the checklist to make sure you have all the facts you need to arrange trip details. If you
discover important information is missing, do more research.

| understand where the destination is located.

| know the climate and can use the facts to offer advice or pick an ideal travel time.
| have information about two sites or events that tourists will enjoy.

| found two interesting facts that will entice tourists to visit the destination.

| gathered two websites with helpful tourist information.

OPTIONAL

| collected additional information on the destination that will allow me to choose from
a variety of options when planning a trip itinerary or creating an advertisement.

Save the Fact Sheet and Close Open Programs
> Click Save &l on the Quick Access toolbar in Microsoft Word.

> Close all open programs.

Copyright © TechnoKids Inc. 9 TechnoTravel | Microsoft 365
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Session 1 Extension Activity: Book Flight or Accommodations

A travel agent arranges transportation to and from a destination. They also
reserve accommodations. Pretend a customer is interested in the weekend
getaway. Locate a suitable flight and hotel.

Explore Flight Options

The customer must fly to reach the destination. You can pick their starting point. It could be your
hometown or elsewhere. However, be practical. A person will only fly so far for a weekend
getaway. Find the customer a flight.

Use the Internet to obtain airfares to your destination. You may want to use the website
www.expedia.com.

Use the Internet to find airfare quotes. At the website select:

type of flight — The customer will need a return flight, which means a person will
fly to the destination and then back home after the visit.

dates for flight — It is a weekend getaway. Pick dates when the person will leave
for the vacation and when they would like to fly home. Will they arrive on Friday
or Saturday morning? Will they leave Sunday night or Monday?

departure airport — Find an airport that is close to your hometown.

destination — Type in a city close to the location of the weekend getaway. You
may need to pick from a list of airports.

number of people - Select one adult.

1. Look at the airfares.
a. What is the price of the most expensive quote?
b. What is the price of the least expensive quote?
2. Compare the most expensive quote to the least expensive. Why do you think there is a

difference? Consider the following factors:

Does time of day make a difference?

Are meals included on the more expensive flight as compared to a "light snack"
on the cheaper flight?

Is there an in-fight movie?

Is the more expensive flight a direct flight or does it have a transfer or stopover
partway through the trip?

What type of plane is booked for the trip? Is it a single engine private jet or a
commercial jet airliner?

3. What would be the best value when comparing the fares? Why?

Copyright © TechnoKids Inc. 12 TechnoTravel | Microsoft 365
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Price Accommodations

Where will tourists stay? Pick a campground, bed and breakfast, motel, or hotel that is central to
the location of the planned activities in the itinerary. How much per night will it cost to stay?

Use the Internet to find suitable accommodations.

At the website select find a room:

e check-in date —Pick a date when the person will arrive. Will it be Friday or
Saturday?

e staying nights — Pick a date when the person will leave. Will it be Sunday or
Monday?

e number of people - Select one adult.

4. Compare the room rates:

a. What is the price of the most expensive room?

b. What is the price of the least expensive room?

5. Compare the most expensive quote to the least expensive. Why do you think there is a
difference? Consider the following factors:

e Doesthe room have extra features such as a jacuzzi or balcony?
e Does the size or number of beds make a difference?

e Are there services such as Wi-Fi or laundry?

6. What would be the best value when comparing the rates? Why?

Copyright © TechnoKids Inc. 13 TechnoTravel | Microsoft 365
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Session 3
BB ¥ Build a Travel Itinerary

In this session, students create a travel itinerary that outlines the activities, site
seeing trips, and events planned for the weekend getaway. Using a table,
students organize the activities for each day. The table is formatted to look

great.

Assignment 10: Plan a Travel Itinerary

Assignment 11: Design a Travel Itinerary

Session3 Review: About Tables

Session 3 Extension Activity: Calculate Travel Costs
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Assignment 11 Design a Travel Itinerary

Session 3

TechnoTravel Agency
/ .
Travel Itinerary
[ saturday | __Sunday |

Breakfast

Walking Tour to view the Falls Zipline to the Falls

. Lunch
Sites and QVGI’]FS Maid of the Mist Butterfly Conservatory
are organized in Dinner

a table Fireworks

Events that last longer are put into multiple cells.

Open the Travel Advertisement in Microsoft PowerPoint
> Go to the place where you saved your work.

> Open the Travel presentation.

View Slide 2

> To move to Slide 2 press the PAGE DOWN key on the keyboard
or click the Slide 2 thumbnail.

Trip Name
Destination Name:

Travel gent: Stusen Har me

Enticing Message to Attract Attention
v B

Insert an Itinerary Slide

> On the Home tab, click the New Slide \j arow.
Choose Title and Content.

Office Theme

Eoe

Title Slide Title and Content ) Section Heade!l

\ e
‘ mASs masy

Two Content Comparison Title Only

Blank Content with Piaurewith
Caption Caption

Copyright © TechnoKids Inc. 33
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Session 3
Make a Table for the Travel Itinerary
D> In the Click to add title placeholder type Travel ltinerary.

> Click Insert Table from the content placeholders.

=N Rl
payeaml

> Set the number of columns to 2 and the rows to 7.
Click OK.

Insert Table ? X

Number of columns: 2

O 4

Number of rows: 7

Apply a Table Style
D> Click the Table Design tab.
> On the Table Styles group, click More “ to see more designs.

~

> Click on a style you like.

Resize the Table
> Place the mouse pointer over the bottom sizing handle.

> Click and drag downwards to make the table larger.

“

When you resize the table, the height
of each cell is automatically adjusted,

@ to make each one the same height.

L PN |
<
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Session 3
Add Table Headings to the Top Row

Add the headings Saturday and Sunday to the top row of the table. You will then change the
alignment of the cells to make the headings look great.

D> Click inside the top left cell. Type Saturday.
Press TAB.

> In the top right cell, type Sunday.

> Place the mouse pointer beside the top row. When the mouse pointer changes to a
black arrow, click the mouse to select the row.

» Saturday Sunday

Click the Table Layout tab.

Explore the following alignment tools in the Alignment group.

Align the words to the left side of the cell.

Align the words in between the left and right side of the cell.
Align the words to the right side of the cell.

Align the words to the top of the cell.

Align the words in between the top and bottom of the cell.

03 o ol il 1

Align the words to the bottom of the cell.

> Use your skills to align the words in the cells.

Arrange Dining Times in the Table

Add the words Breakfast, Lunch, and Dinner to the table. These words will be centered in the
middle of the table by merging the cells in a row to create one large cell.

> Add dining times to the table:

o0 Inthe second row, type Breakfast.
o In the fourth row, type Lunch.

o0 In the sixth row, type Dinner.

> Move the mouse pointer to the outside of the second row. When the pointer changes to
a black arrow, click to select the entire row.

Soturday sunday |
» Breakfast

> Click the Table Layout tab, and from the Merge group, click Merge Cells. ES

> Use your skills to merge the cells in the Lunch and Dinner rows. Align the words in the cells.
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Organize Activities in the Table

Add the names of the events or sites that tourists will visit when they are on the weekend
getaway. Use the information from Assignment 10.

> Click inside the first empty cell below Breakfast.
Type the Activity Name into the table.

> Use the TAB key, or the mouse to move to each empty cell and complete the itinerary.

> Use your skills to make the table look great.

Travel Itinerary i
Saturday Sunday
Breakfast

Activity | Activity

Lunch
Activity | Activity

Dinner
Activity | Activity

Complete the Itinerary Slide Checklist

Use the checklist to edit the itinerary slide. Do you need to make changes?

Does the title describe the information on the slide?

Does the table have headings that are easy to read?

Does the travel itinerary have dining times including breakfast, lunch, and dinner?

Are the activities selected for the travel itinerary suitable for tourists?

Are the activities arranged in a practical way that gives tourists enough time?

Does the table have a style that makes the information easy to read?

Is the information aligned in the table cells?

Save Changes and Close Microsoft PowerPoint
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Session 3 Review: About Tables

Pick the command to do the job.

1. You want to insert a table onto a slide.
2 HE
b) =
c)

2. You want to align words in a cell to the bottom.
a =
) [E
o [E
3. You want to merge two cells together to make one big cell.
a) i

by
o [=

4, You want to align words in a cell to the left side.
a) E
b) [
0 =
5. You want to see more table styles.
a) +
b)
o v

/5
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Answer the question about using a table.

6. Why is it a good idea to use a table to organize information?
it makes the information easy to read
it makes the information easy to understand

it makes the information look good

/2
How do you do it? Pick the correct method.
7. How do you select a row?
a) Put the mouse beside the row. Click when the pointer changes to a black arrow.
b) Put the mouse pointer above the column. Double click when the mouse pointer
changes to a black arrow.
C) Double click the table.
8. How do you resize a table?
a) Double click the table.
b) Click and drag a sizing handle on the table.
C) Click and drag on the center of the table.
9. What keyboard key moves the cursor to the next cell in a table?
a) TAB
b) ENTER
C) SPACEBAR
/3
TOTAL /10
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-@ Appendices

Refer to the appendices for additional resources:

Appendix A: Assessment Tools
Research and Image Checklist
Slide Master Checklist
Travel Research Marking Sheet
Travel Ad Marking Sheet
TechnoTravel Skill Summary

Appendix B: Contact Information
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Appendices

Travel Advertisement Marking Sheet

Slide Master Design

e design is unique ¢ placeholder layout is balanced
e color scheme is attractive o title slide does not have a header or footer
o text formatting is easy to read ¢ date, slide number, and travel agency name are on each slide /6

Slide Content

Title Slide

« title identifies travel destination * slide includes student name /2

Information Slide

o title attracts attention o facts about climate provide useful information

e facts entice tourists to Visit e picture is formatted to look attractive /6
Itinerary Slide

¢ dining times are included ¢ headings organize information logically

e activities are suitable for tourists ¢ table style makes information easy to read

« activities are practically arranged ¢ information is aligned in table cells /6

Activity Slides

« activities are clearly described ¢ wording persuades tourist to take the trip

« pictures showcase the activities ¢ various slide layouts add interest to the advertisement

* slides have a balanced layout /10
Map Slide

o map shows the location of the trip ¢ symbol correctly marks the destination

o label identifies the location o formatting choices create an eye-catching slide /4

Learn More Slide

o text links to a helpful tourist website ¢ hotspot links to a helpful tourist website

o hyperlinks work correctly o formatting choices create an eye-catching slide /4
Presentation

¢ spelling is correct ¢ slide order is logical /2

Travel Advertisement Output Options

Advertisement in Kiosk Mode

« transitions are between slides * slide show plays automatically and loops /2

Advertisement as a Flyer or Brochure

* handout has customized headers and footers that create a unique design

e print layout options produce an attractive handout /2

Advertisement as a Video

* slide advancement allows all information to be read easily /1

Comments:

/45
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RESOURCE

This course includes a sample of a completed project.
Teachers can use this resource for demonstration purposes
or as a source of inspiration.
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Weekend Getaway
Niagara Falls

Travel Agent: Jake Rayner




TechnoTravel Agency

" Yisit N iagara Falls

o Nakina
:‘. /_,__,——o!(z

Nipigeon

\ake Superior S g Wawa
F; | \

8/12/2021



TechnoTravel Agency

4 .
Escape to Niagara Falls

»Gaze at a true wonder of the »No matter the season, this is a
world. fabulous vacation destination.
= Niagara Falls is the second largest " In the winter, as the temperatures
waterfall on the globe. drop below freezing you can
= Admire the rushing water as it marvel at the naturally forming
olunges 54m from the top of the snow sculptures at the base of the
falls to the river below. Falls.

" In the summer as the
temperatures climb to 302C enjoy
the beauty of the rushing water.

8/12/2021
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: Butterfly Conservatory A

» Marvel at the exotic butterflies '
as they soar through the |
conservatory.

» Wander the pathways to see
hundreds of fluttering
butterflies.

= Go beyond the conservatory to
enjoy the Botanical Gardens.

8/12/2021
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Maid of the Mist

» Take a boat ride to the base of the waterfall.
» Soak in the excitement as you explore the roar of the Falls.

8/12/2021
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Fireworks

» Enjoy the thrill of a fireworks display over the Falls.
As the sun disappears, the light show begins.

| 4

2021-08-12
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" Zipline to the Falls

» Experience the breathtaking thrill of gliding to the base of
the Horseshoe Falls.

= Soar down 67 metres with an outstanding panoramic view of the
gorge.

= ‘Fly’ alongside your friends
on 4 parallel ziplines.

2021-08-12




TechnoTravel Agency

4 .
Travel Itinerary

Breakfast
Walking Tour to view the Falls Zipline to the Falls

Lunch
Maid of the Mist Butterfly Conservatory

Dinner

Fireworks

8/12/2021
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/

Learn More

»Learn more about Niagara Falls.
»Visit http://www.niagarafallstourism.com/

Click the picture to visit Tourism Niagara

8/12/2021
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